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Welcome! 
We hope you enjoy using eSearch Pro | TARILIO. 
 
eSearch Pro combines advanced information retrieval with an integrated AI 
Mode that offers multiple connections to online Large Language Model (LLM) 
Provider APIs and/or locally installed LLMs and MCP Servers for enhanced 
productivity. 
 
• Scrollable word list: Quickly discover vocabulary or spot typos in a 

document collection. Gain rapid insights into a case, project, or prior 
research. In AI Mode the word list displays question stems for AI-
powered web search or assistance. 
 

• Efficient search: Double-click on a word in the word list or select it 
and press Enter to insert it in the search bar to minimize typos. 
Forward slash (/) shortcut puts the cursor in the search bar.  
 

AI Mode    Voice input option: 
 
 

• AND, OR, NOT buttons: For quick and foolproof entry of Boolean operators. 
Operators which you type are automatically uppercased! 
 

• For Legal professionals: Use List of keyword search queries to share 
with others. For Early Case Assessment (ECA), case reviews, etc.  
 

• Sort search results by filetype, title, size, chronologically, or 
automatically extracted meta data. 
 

• Expand search with multilingual stemming and synonyms with pre-defined 
and user defined thesaurus files. 
 

• Export timestamped search results & reports in XML, comma or tab 
separated formats, with selected metadata included. 
 

• Viewer supports plain text with keyword highlighting, built-in PDF 
viewer, colour syntax highlighting and line numbers in source code. 
Tables for csv files. Images with geolocation on map. Player for web 
format audio & videos files. 
 

• User Interface (UI) is User translatable. French and German supplied. 
Free Language File Editor. 
 

• Dark mode/high contrast theme options for eye comfort. Horizontal or 
Vertical Viewer layout options. 
 

• Portable version can be run from a USB drive with nothing installed on 
the host machine. Index and search files on the host machine for 
IT/investigative use, or create a portable library of projects, 
research, newsletters or more for your own use, or publish search-only 
copies with no expiry. 
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Installation & System Requirements 
NOTICE 

eSearch Pro and eSearch Portable are open-sourced and free of charge for 
private, non-commercial use. TARILIO versions include closed source code 
and are for commercial use.  

 
They are self-contained x64-bit .NET 8.0 applications. Install on any 
Windows 10 or 11 machine without worrying about the .NET runtime version 
installed on that machine. The .NET runtimes and all necessary libraries 
within the application itself to ensure it runs smoothly with the exact 
version it was tested with. 

How to Install eSearch Pro or TARILIO 
• Download the esearch_installer.zip file, this consists of a zipped 

Microsoft Software Installer (.msi) file.  
• Extract the file, right-click and choose Extract All... 
• Double-click on the .msi file and follow the instructions.  

The default install path is under the Program Files folder. User 
settings are stored in the Users\Username\AppData\Roaming folder.  

• TARILIO versions: Enter your serial number on the Help > About 
window. 

IT departments can disable indexing if required by adding an -s command-
line parameter to the Windows shortcut. (Note: this is not the same as the 
non-expiry Portable – Search-Only version). 

Disk Space required: 2Gb minimum. Additional space is required for the 
indexes.  

Unlike some search products that simply index everything on the installed 
drive, you can select specific folders and files to include in an index. 
You can also quickly select by file type or a category of file types using 
a tree view control – see Filetype Filter. 

How to upgrade to a later version 
 
1. In Windows go to Add or Remove programs, navigate to eSearch Pro and 
choose to uninstall. It will not remove your indexes in the Desktop 
version. If you are upgrading the Portable version, see Updating. 

2. Install the latest version as above. 
 
3. From the Index menu, select Manage Indexes... Press Rebuild for each 
index to ensure the latest file parsers are being used. 
  



5 
 

Install eSearch Portable on a USB 3.x drive 
 
See also eSearch Portable - Forensics and eSearch Portable - Publishing 

If an older eSearch Portable version is on the USB drive, see UPDATING 
below: 

New Install 

• Download the eSearchPortable.zip file.  
• Right-click on the file and choose Extract All...  
• Click on Browse... select the USB drive. 
• Click Extract. 

  

 

 

. 

 

 

 

 

• Click on run.bat to start eSearch 
Portable.  

• Enter your serial number in the 
Help > About window. 

• To index and search files on the 
USB drive, create a “docs” folder 
(and sub-folders if needed) and 
keeps all the files under there. 

 

Updating 
The Portable version stores user settings in the ProgramData folder 
within the eSearchPortable directory.  
 

• Before carrying out the instructions under NEW INSTALL, click on 
save-data.bat, this will rename the ProgramData folder on the USB to 
ProgramDataOLD.  
 

• Next, carry out the NEW INSTALL steps, select overwrite existing 
files when prompted.  
 

• Click on run.bat to start eSearch Portable as before. It will 
automatically rename the Program Data folder to ProgramDataNEW and 
rename ProgramDataOLD to ProgramData if it exists. 
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Quick Start 
Go straight to the View menu, choose your language, theme and layout. 
 
Need to translate the UI? See: Translation 

 
eSearch uses indexes to locate information fast!  
 
Go to the Index menu. choose New… 
 
Enter a meaningful name for the index 

Add Files  or Folders  
 
For more information see: Index 
 

Support Articles: 
 https://searchcloudone.com/esearch-support-articles/ 

 
You’re now ready to search! 

See: Search Queries 

 

If you later edit, add or remove documents, go to Index menu > Manage 
Indexes… to Update, Rebuild, Rename, remove files from the index, or 
Delete the index. 
 

 

https://searchcloudone.com/esearch-support-articles/
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Index 
Enter a name for the index, e.g. Closed-Cases, Recipes-Vegetarian, 
Projects-old. 
 
We recommend maintaining indexes small and specific. Separate archived or 
infrequently changed material from files that are frequently edited. This 
approach simplifies updates and enhances overall manageability. 
 
Choose Folder or File, you can add multiple files and multiple folders in 
the same index and apply filetype filters as needed. You should also check 
that Settings… are appropriate. 
 

File Explorer 
 
To select multiple files in a range, select the first file, hold down the 
Shift key, and then press the Down arrow key to select the rows. To select 
another range, hold down the Ctrl key and use the Down arrow key to skip 
unwanted rows. Then, press Shift + Ctrl + Down arrow key to select 
additional rows. 
 

 
 
To select multiple files, hold down the Ctrl key and use the Down arrow 
key to skip unwanted rows. Select rows by clicking the checkbox with the 
mouse or by pressing the spacebar. 
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Indexing Options 
 

Filetype filter  
(Pro version. Lite version defaults to Include All) 

When creating or updating an index you can select which file types to 
include. This is useful when indexing a Folder that may have nested 
folders containing filetypes that are not of interest and is quicker than 
having to select Files to index. 

You can select all or parts of a category or individual filetypes from the 
tree view: 

 

 

If Include All is selected it will 
only exclude a list of known 
executable extensions. It will 
attempt to parse every 
unrecognised filetype as well as 
all the filetypes in the tree 
view. 

If you need to index a Folder with 
unknown filetypes, especially if 
the file(s) are large, we 
recommend a trial index of a 
single File to check it will be 
handled. 

 
 

 

 

Click on   Settings…  for more options that may be needed. 
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Search Queries 

By default, eSearch Pro will search-as-you-type and list all the documents 
in the selected index without having to enter a search query. (You can 
change the default behaviour from Search settings). 

Enter a search query to limit the results list to just the files of 
interest. Search queries can just be a list of keywords like dog hound 
pooch (DON’T separate with commas or other characters). 

Choose ALL if you want the words joined by AND, this will narrow your 
search the more words you add; remove words if you get no results. Word 
order does not matter. 

Choosing ANY is a last resort for a broad search. 

For more precise searching use Boolean AND OR NOT operators.  

 Example Query Will find files containing: 

Boolean dog AND cat both words dog and cat. 
dog OR cat dog or cat or both words. 
dog NOT cat dog and not cat. 

Proximity “cat mouse”~10 mouse within 10 words of 
cat. 

Phrase "dog kennel" the exact phrase 'dog 
kennel'. 

Wildcards 
 
(Do NOT use 
at the 
start of a 
word.) 

dog* dogma, doggy, dogfish, etc.  
(* replaces several 
characters) 

moderni?e, modernize or modernise 
(? replaces a single 
character) 

Fuzzy word~ 
500~ 

similar words or numbers. 
 

Fields Some files may 
contain fields you 
can search like 
Fieldname:  
 
e.g. 
Content-Length:500~ 

 
 
 
 
 
File size of approximately 
500 bytes. 
 

Regular 
Expressions 

/[mh]otel/ either motel or hotel 
 

Note: Synonyms includes a Numeric Pattern file that has a regular expression for finding IPv4 addresses. 
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Scrollable Word List 
 

Search-as-you-type 
As you type a word in the search query bar, it will ‘search as you type’. 
At the same time, the word list will scroll to the matching word. An 
alternative to typing, especially if you are unfamiliar with the content 
of the index, is to scroll through the word list and double-click on a 
word of interest. It will then be entered as a search query. 
 

Intelligent indexing  

 
The word list keeps numbers and letters separated by punctuation together. 
For example, complete IP addresses and sums of money appear in the word 
list unbroken, as do possessive apostrophes and contractions. 

Email addresses are split at the “@” symbol, so domains and email aliases 
appear separately in the word list. You can search for all users at 
contoso.com by entering that as the search query (do NOT use a wildcard). 
Alternatively, you can enter an alias like jon.doe to find all emails with 
that alias at any domain, such as jon.doe@gmail.com or 
jon.doe@contoso.com. To search for the exact email, use both the alias and 
domain in quotes with the “@” sign, e.g., “jon.doe@contoso.com”. 
 
eSearch Pro includes a useful regular expression in the pre-defined 
synonyms list for searching for IPv4 addresses. To use it, go to Search 
Settings and select the Sample Numeric Patterns, select Synonyms and just 
enter “IPV4” as the search query. 
 

 

The image above shows IPV4 search query used to find and highlight all 
IPv4 addresses.   
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Use List option 
 
Intended for using a ‘Keyword List’ during eDiscovery (eDisclosure) by 
case reviewers. To create a list the first step is to sample the dataset.  
 
1) Create an index of a sample of the data and use the fully scrollable 
word list to quickly identify the vocabulary, jargon & abbreviations used. 

2) Create a file in NotePad or similar text editor and save it in Unicode 
format. The file should contain a list of keywords (words that you 
identified as important from the word list) or valid search queries, one 
per line. Leave no blank lines. Save it in your Documents folder or with 
your case files, we recommend the filename should have a timestamp and 
suitable file name e.g. Case479_2024-04-01. 
 
3) Open the Search Settings window and check the Use List checkbox.  

 

 

 

 

 

 

 

4) Click on the navigation button and open the file you created 
above. Click OK. The search query will appear in the search bar. 

5) Select the index and press search:  

You can expand the search using stemming or synonyms to discover 
additional responsive documents. 

6) Choose suitable columns from Results Settings:  

  

 

7) Click on column headers in the results table to sort as needed. 

8) Check the checkbox next to any row to select for export by pressing the 
space bar. 

9) Go to the File Menu and select Export Search Results. This allows you 
to choose which results and columns to export in a timestamped file in 
.xml, comma, or tab-separated formats for import into Excel or other 
software for further review or sharing with others.  
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Stemming & Synonym options 
 
 

 

Check either of these to expand a search. 
 

Stemming 

Stemming will expand a search term such as “apply” using different word 
endings such as applied, applies, applying.  

You need to select the correct language from Search Settings.  

 

 

There is a choice of English Porter Stemming or stemming in English or 30 
other languages. A vocabulary file for evaluating the Porter Stemmer is 
available from here: https://tartarus.org/martin/PorterStemmer/ 

 

Note: when using the Case Sensitive index option, Stemming should be 
deselected. If Stemming in eSearch Pro is selected it will expand a search 
by making it case-insensitive as well by using different word endings. 

 

Synonyms 
 
Synonyms will expand a search with user-defined or the supplied pre-
defined synonym files in several languages.  

You need to select one or more of either type from Search Settings. 
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Soundex 
If you are unsure of the spelling of a person’s name, use the Soundex 
option to expand the search to similar sounding names.  

Soundex matches names that sound similar but have different spellings. It 
was used by the National Archives to index the U.S. censuses. 
https://www.archives.gov/research/census/soundex 

A limitation of the Soundex algorithm is that words must start with the 
same letter to be considered a match. For instance, a search for “Smith” 
will also find “Smithe” and “Smythe”, and a search for “Philipp” will find 
“Phillipe” or “Philip”, but it will not find “Filip” because it begins 
with a different letter.  

If you have also selected Stemming, it will find “Phillips”, “Philips”, 
etc. which may or not be desirable depending on the purpose of your 
search.  

 

Example shows a search for “Robert 
Smith”, with Soundex option 
selected will also find “Rupert 
Smith”.  

 

 

Names-3: Robert Smith 

 

 

 

 

 

 

 

 

 

Soundex is based on English pronunciation, which can lead to inaccuracies 
with some European names. For instance, the French name ‘Roux’ has a 
silent ‘x’. Although ‘Roux’ and ‘Rue’ are pronounced the same, they 
receive different Soundex codes: R000 and R200, respectively. 

https://en.wikipedia.org/wiki/Soundex 

 

https://www.archives.gov/research/census/soundex
https://en.wikipedia.org/wiki/Soundex
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Settings 

Search Settings 
 

Use List 
see separate section. 

 
Stemming 
Stemming Language should 
match the language of your 
search queries. 

 

List Index Contents on 
empty query 

The default setting is on. 
Turn it off if you have many 
large files in the index, as 
it can make searching 
sluggish. 

Search as you type 
The default setting in on. 

 

 

 

Synonym Files 
 
Pre-defined synonym files are available in multiple languages. You can 
also select 1, 2, or 3 from the Synonym Files list to add your own user-
defined synonym groups.  
 

In addition to synonyms, you can include related or equivalent words or 
phrases in other languages. Regular expressions are supported as well. For 
example, the sample numeric patterns file includes a regular expression to 
find IPv4 addresses. 
 
You can select multiple synonym files. For instance, if you are searching 
through a mix of English and Spanish texts, you might want to select the 
English irregular verbs and nouns, as well as the Spanish irregular nouns 
and verbs. Additionally, you can add your own subject-specific synonym 
group. 

Danish irregular nouns 
Danish irregular verbs 

Sample months 
Sample names cross lingual 
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Dutch irregular nouns 
Dutch irregular verbs 
English irregular nouns 
English irregular verbs 
French irregular verbs 
Italian irregular verbs 
Norwegian irregular nouns 
Norwegian irregular verbs 
Sample colours 
Sample currencies 
Sample days 
Sample fashion 
Sample geographic 
Sample Jours de la semaine français 
Sample legal 
Sample medical 

Sample names genealogy 
Sample names political 
Sample names Russian female 
Sample names Russian male 
Sample numbers 
Sample numeric patterns 
Sample Prenoms Francais Masculins 
Sample trade 
Sample Unregelmäßige Deutsche Verben 
Sample Verbe Irrégulier Français 
Sample Wochentage Deutsch 
Spanish irregular verbs 
Swedish irregular nouns 
Swedish irregular verbs 
 

 

Note: the sample numeric patterns file contains regular expressions for IP 
addresses and credit-cards. The IPv6 example will not currently work with 
eSearch Pro indexes because the colon (:) character is treated as a space 
with no option to change it. 

The Amex, Visa and Diners card regular expressions may work; however, they 
are not foolproof. They might detect patterns that are not credit card 
numbers or miss valid card numbers, as there is no checksum validation. 
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Results Settings 
 

  

 
 
 

 

Columns 
The list includes metadata automatically collected from the files in your 
current index. For example, if emails are included, it may show ‘To’, 
‘From’, and ‘Subject’. If images are included, it may show geolocation, 
DateTime, and camera details of a photo. 

Drag and drop columns to reorder them. Press OK to save the settings and 
close the window. Unselected columns will fall to the bottom after the 
window is closed. 

Sort results by any column by clicking on the column header in the results 
list 

Column Width 
This is remembered if you choose ‘Set Manually’. 
 

Rows  
You can set the number of rows to display in the results table. 
5000 is the maximum, but you may prefer to set to a lower number for a 
quicker response.   
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Viewer Settings 
Viewer 
Settings 

 
Map Pin 

 

 

 

The Map Pin button is a Pro version feature, it is displayed when images with 
geolocation metadata are viewed. 
 

View Large File: 
Large files may be 
very slow to open 
in the viewer, 
choose Report View 
to quickly show 
only keywords in 
context (KWIC). 

 
You can select the 
colour of the 
highlighted words 
or set the size and 
font of the text in 
the Plain Text 
view. 

 

 

 
Small images may be better viewed in horizontal mode to increase size. 
Change the layout in the View menu from Vertical to Horizontal. 

 

PDF: See PDF Options.  
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PDF Options 
You can view as text with hits highlighted in your choice of colour or use 
the built-in PDF viewer as shown below. 

 

Built in PDF Viewer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Illustration shows sample German UI translation. Viewing a 25Mb PDF as 
Plain Text with highlighted hits.  
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Geolocation in images 
From Results Settings select the metadata you want to display. Images in 
many formats are displayed in the Viewer. Automatically extracted metadata 
includes full geolocation, camera details, etc. You can sort on any 
column. 

 

 
Click on the Map Pin button to view the location on a map. (Pro only) 

From the File menu, choose Export Search Results. Select metadata, then 
choose .csv for output of a timestamped file to Excel.  
 
Images above use geolocation test photos from 
https://www.geoimgr.com/sample-photos.html  

https://www.geoimgr.com/sample-photos.html
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Audio & Video files 
 

 

 

Web format audio and video container files, such as (.wav, .mp3, .mp4, 
.ogg, .webm), contain different audio and video codecs, not all of which 
may play in the viewer. For files that don’t play in the viewer, we 
recommend installing VLC Media Player and click on ‘View in folder’ 

 
Ensure that VLC Media Player is set as the default for opening the 
filetypes in your indexes.VLC is a free and open-source cross-platform 
multimedia player, it can be downloaded from https://www.videolan.org/vlc/   

 
If your collection contains little meta data, use the default search 
setting to return all files in the index with an empty search query. 

The results are limited to 5000. For larger collections split your files 
up so that different formats, subject areas, projects, dates, etc. are in 
different folders. Create a separate index for each folder.  

 

 

VLC Player can also be used for static image files. 

  

https://www.videolan.org/vlc/
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Data files 
 

 

CSV and JSONL files are indexed as records, with table layout preserved 
and hits highlighted. Indexing is fast, over a million such records can be 
extracted from a zipped CSV and indexed in a minute on a modern PC. 

 

Showing 100,000 row JSONL file indexed with no stop words. Index time 2-3 
minutes on a Windows 11 office PC with a single 12th gen Intel CPU with 
32Gb RAM. Hansard Sequences file is available here: 
https://github.com/stewhsource/GovernmentGPT/blob/main/README.md 

 

 

 

 

 

 

 

 

https://github.com/stewhsource/GovernmentGPT/blob/main/README.md
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Source Code files 
 

 

 
 

 

 

 

 

 

Hit highlighting in source code with syntax highlighting & line numbers. 
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Translation file support 

 

 

Translation industry file formats XLIFF 1.2, XLIFF 2.0, .tbx, and .tmx are 
supported for small files only. The image shows an index with the Case 
Sensitive option enabled, ensuring that acronyms and abbreviations are 
found. Additionally, contractions like d’un are preserved in the index and 
appear in the word list. 

 

eSearch Pro 1.0 currently lacks file segmentation functionality, which 
splits large data files, such as translation industry XML formats, by rows 
or nodes, allowing them to be indexed as separate files. However, it will 
index CSV or JSONL formats with each record treated as a separate file. 

 

The free GSplit 3.0 by G.D.G. Software SARL can be used for splitting 
translation industry XML formats. 
https://www.gdgsoft.com/gsplit The UI is available in many languages. 
 

 

  

https://www.gdgsoft.com/gsplit
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Index Settings 
 

 

Settings will not take effect 
until you Rebuild an index. 

 

 

 

 

 

 

 

 

 

 

 

Stop words 
Stop words (also known as noise words) are frequently used words that are 
not included in an index to save indexing time and storage space.  
 

Choose from a list of stop words in 30 languages or you can choose ‘None’ 
(at top of the list). If you change the stop words used by an index, you 
will need to rebuild the index for the change to take effect. You can edit 
the stop words from the  ..AppData\Roaming\eSearch\Stop folder. 

 

Maximum word length 
The default setting is 0, which means no limit. (The actual limit is 
currently 125). You may prefer to lower this if your documents contain 
many long strings of letters or numbers. 

 

Maximum File Size 
The default setting is 0, which means no limit. 

Case Sensitive 
If Case sensitive is selected it will index language, LANGUAGE and 
Language as three separate words; it is useful for more precise searching, 
for example distinguishing wax polish from Polish (a person from Poland), 
chapter titles, brand names (Apple NOT apple) or acronyms and  

cont…  
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cont…  

abbreviations (PIN NOT pin). Indexes will be larger with this option. 
 

Note: Stemming should be disabled for case-sensitive searches.  
 
In eSearch, stemming will broaden the search by making it case-insensitive 
and expanding it to include words with different endings. (e.g. a search 
on ‘title’ will find TITLE, Title, title, titles). 
 

 

 

With the ‘Case sensitive’ option selected the word list shows 
alphabetically sorted uppercase words and letters as well as accented 
words. eSearch also correctly retains possessive apostrophes (‘s) and 
contractions like d’un in the word list. 
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AI Mode 

Connection to AI Services is setup from the AI > AI Connections menu. 
 
The Perplexity service uses up-to-date web 
search combined with a choice of fast non-
reasoning or slower reasoning models. 

Usage requires a Perplexity.ai API key. 
This is a pre-pay pay-as-you-go service, no 
paid subscription is required. 
https://www.perplexity.ai/settings/api 
 
Select the Perplexity Model, enter your 
API-key, Press Test to check the 
connection. 

Click on the AI Mode button (blue button in 
the image below) to toggle between indexed 
and AI mode. In AI mode the Model will be 
displayed at the top of the viewer window.  
 

 
The suggested question stems in the word list boost your productivity. 
Simply double-click on a word, or select it and press Enter, to insert it 
into the search bar. 
 
Enter the remainder of the question. Optionally, add instructions to 
provide the answer in any language. Press Enter. 
 
Verify the answer or get further information by clicking on any of the 
links to open them in your browser. 
 

 

The image above shows AI Mode using Perplexity Sonar Pro. Apart from 
Perplexity models, OpenAI’s ChatGPT and Custom services are available.  

https://www.perplexity.ai/settings/api
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AI - Connecting to Custom API’s 
 
From the Service drop-down list, select ‘Custom’ to connect to any OpenAI-
Compatible service, such as a local LLM or another online LLM API 
provider, to access the latest models. You can also enter a system prompt 
to meet your organization’s exact search needs. 

 
Setup allows you to add (+) or 
Remove (-) connections. 

Rename connections, to identify 
services and models or 
associate them with projects or 
cases to control costs.  

A security best practice is to 
rotate API-keys, setup allows 
you to edit the API-key. 

You can add other Perplexity 
models via the Custom form. 
Note the server URL is: 
https://api.perplexity.ai 
(Do not add /v1) 
 

 
Online services usually require the 
organization’s owner, such as an IT 
department, to setup projects with 
different API keys. These projects can 
have limits set such as token usage or 
be restricted to specific models, 
allowing for controlled costs and 
allocation to specific cases, 
projects, or users.  
 

Image above shows OpenAI project setup. 

Locally run LLMs have the advantage that they are free, there is no need 
to pay subscriptions or usage charges. Security and privacy concerns such 
as keeping your queries and outputs within your organisation, as well as 
access to uncensored or fine-tuned domain specific models are other 
advantages of running local LLMs. It is possible to locally run quantized 
versions even on machines with a single CPU or modest GPU. For more 
information see the Support Articles 

It's prudent to use online services initially. This approach allows you to 
test and compare models to determine the best fit for your organization’s 
needs while managing costs effectively. Unified services like 
Openrouter.ai allow access to hundreds of models – including free models - 
with a single API Key and with no subscription. 
 

https://searchcloudone.com/esearch-support-articles/
https://openrouter.ai/
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Usage of AI Models 
 
When you click on the AI mode button it will toggle between indexing and 
AI mode, ready to start a new multi-turn conversation. The button will be 
highlighted - in blue on image below – to indicate AI mode.  

Select the model/service from the drop-down as shown in the image below. 

 

 
Above shows a multi-part conversation with a free locally hosted LLM. 

Be aware that models without web search capabilities, or without access to 
an up-to-date document collection, will have a knowledge cutoff date and 
usually won’t include citations or links to sources on the web.  

In the image above the small non-reasoning Gemma 3 4B quantized LLM is 
able to get the real time by using the Time MCP Server. 

Non-reasoning models will usually give faster answers. 

 

For more information on AI mode see the Support Articles.  

https://searchcloudone.com/esearch-support-articles/


29 
 

MCP Client 
 
eSearch Pro has a built-in Model Context Protocol (MCP) Client. From the 
AI menu select MCP Servers. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select + to add a new server. Copy the MCP server configuration (usually 
published with an MCP server) and paste it in the Configuration window. 

 
Select run  

After a short while it will display that it is 
running.  

 

It is best to have only one or two servers running at once. Stop any 
unwanted servers. 

 

 

 

If an error occurs you may need to edit the configuration, some MCP 
servers need you to enter paths to folders, or API keys. 

 

 

(Anthropic have now published a standard for a one-click install DSK file 
format, this will be added in future versions).  
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eSearch Portable – Forensics 
 
eSearch Portable is designed to run from a USB 3.x flash drive. It 
requires read-only access to the host machine and does not install files 
on it. Indexes and user settings are saved on the USB flash drive. 

However, if you intend to search for and retrieve files of interest from 
the host machine for forensic purposes, where evidence may be needed for 
legal proceedings, you must take precautions to ensure the files are not 
altered in any way. Additionally, ensure that no accidental changes are 
made to the host machine. 

USB flash drives are usually supplied formatted as FAT32, which is 
generally the preferred format to ensure fast read/write operations. 
However, if you intend to copy files from the host machine to the USB 
flash drive, consider the following: 

1. File System Choice: For forensic investigations, NTFS is generally 
preferred over FAT32 because it provides more precise timestamp 
information and better handles time zone and DST changes. NTFS timestamps 
include created, modified, accessed, and entry modified times, all with 
high precision. 

2. Preservation of Timestamps: When copying files from NTFS to FAT32, 
there can be a loss of precision and potential discrepancies due to the 2-
second granularity of FAT32 timestamps. This can be problematic in 
forensic contexts where exact times are critical. 

3. Daylight Saving Time (DST): FAT32 does not account for time zone or DST 
changes, which can lead to inconsistencies if files are accessed or 
modified across different systems with varying DST settings. NTFS, on the 
other hand, handles these changes more robustly. 

4. Forensic Tools: Use specialized forensic tools that can preserve and 
analyse timestamps accurately. Tools like EnCase, FTK, or X-Ways Forensics 
are designed to handle these tasks and can help ensure the integrity of 
timestamp data during investigations. 

5. File Integrity:  Use write-blockers when accessing storage devices to 
prevent any changes to the data, including timestamps. This helps maintain 
the integrity of the evidence. 
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eSearch Portable – Publishing 
 
If you want to index and search files on a USB drive, create a “docs” 
folder (and sub-folders if needed) and place all the files there. Then, 
create one or more indexes of those folders. Do not copy indexes created 
by eSearch Pro from a machine to the USB drive, they are not suitable. 
 
The standard license covers the installation of one copy on one USB flash 
drive. You can make a backup copy for your own archival purposes.  

 
Publishing 

If you want to make multiple copies for distribution to others (to search 
only the documents on the USB flash drive with no expiry) please contact 
us so that we can issue the required license and serial number to enable 
that functionality. (This requires a TARILIO version). 

 

It is possible to distribute a searchable collection of documents and 
images within an organization or to clients (e.g., accounts, reports, 
project data, legal documents, ‘e-Bibles’) either freely or for sale. We 
offer one-time or annual licenses. Please contact us with your 
requirements. 
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Plugins 
eSearch Pro supports plugins to extend its functionality. For example, 
it’s possible to index files outside of the local file system using a 
plugin.  

A free plugin that can index files on an Amazon S3 store is available from 
here: https://searchcloudone.com/plugins-for-esearch-pro/ 

 
To install the plugin: 

1 Download the plugin file to a folder on your local file system. 

2 Right-click on the .zip file and choose Extract all… 

2 Click on the Plugins menu, then press the Add… button. Navigate to the 
extracted plugin file and click Open 

 

 
The plugin will now appear on the Plugins list: 

 
 

 

 

 

 

 

 

 

 

Continue… 

https://searchcloudone.com/plugins-for-esearch-pro/


33 
 

Now click on the Index > New… menu, the Create Index window will appear. 
Click on the new button (outlined in red in the image below). 

 

 

 

 

 

 

 

 

 

 

 

 

The Bucket Name and Region is a 
demonstration bucket. You do not need to 
enter any other details.  
Press OK. 

 
If you have files stored in an Amazon S3 
Bucket that is not public, you will need to 
enter the correct Bucket Name and Region, 
then check the Authenticate box and enter 
the Access key and Secret key before 
pressing OK. 

 

 

 

 

 

 

Edit the Index 
Name to ‘S3 Demo 
Bucket’ for 
example.  

Press OK. 

 

Continue… 
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The new index will be created in a few seconds, close the dialog.  
The new index will be automatically selected. Search the files as usual. 

Example of an ‘All Words’ search for the words speculative, decoder.  

Example of an ‘Any’ word search for the words speculative, decoder. 

Settings: 
Stemming: on. As a result, it will also find decoding. 
View: Horizontal. Results Settings: Name & Type columns, Fit to Content. 
Viewer Settings: Plain Text. Highlight (RGB): 00FF00 Font: Segoe UI 14pt. 

Acknowledgement: 
The files in the S3 bucket are a collection of files from the open-source 
and free course by Decoding ML here:  
https://github.com/decodingml/second-brain-ai-assistant-course 
  

https://github.com/decodingml/second-brain-ai-assistant-course
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Keyboard Shortcuts 
 
Online Help – Press the F1 key. 

Forward slash key / to put the cursor in the search bar. 

Ctrl + Shift + V to toggle voice input. 

 

UI Navigation 

Use Tab or Shift + Tab keys to navigate between the menu bar, search query 
controls, toolbars, results and viewer frames. You can use the up/down 
keys to navigate between menu items, word list items, toolbar items, 
result rows, etc. 

 

Menus 

The menus use conventional ALT + hotkey shortcuts. Press the ALT key to 
see the underlined character to use as the hotkey. The English UI uses the 
first letter as the key by default, but other languages may differ to 
avoid duplicate keys. Users can also create their own English language 
file as an alternative to the built-in English (GB) defaults (e.g., US, 
AU, CA, or even GB if you prefer to add your own words or shortcuts).  

 

Results grid 

Use the Up/Down keys to navigate rows.  

Use Shift + Up/Down keys to select multiple rows, CTRL + Up/down to move 
without selecting, then Shift + CTRL + Up/down to select further rows. 

With the focus on the results panel, select all rows using Ctrl + A. 

See also: File Explorer 

 
Word List 
Use the Up/Down keys to navigate through the list, and press Enter or 
double-click with a mouse to use the selected word in a search query. 
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User Translation 
View menu  
The User Interface (UI) Language is English by default, choose from the 
supplied languages by selecting From File…  
 
The UI language changes instantly, no need to restart!  
 

Language File Editor 
Our aim is to make eSearch available in many languages. We provide sample 
translation files in several languages.  

You can edit the language files to add missing translations or correct 
errors. You can also change shortcut keys or modify user interface wording 
to suit your preferences.  

We offer a free Language File Editor to make translation quick and error-
free! Download the free Language File Editor from 
https://searchcloudone.com/universal-desktop-search/  

 

If you would like to donate translations for use by others, please send 
them zipped to support@electronart.co.uk. We will publish or distribute 
them free of charge on as AS-IS basis, with no warranty of accuracy or 
completeness. Please let us know if you have any questions. 

See: https://github.com/electronart/esearch-project-translation 

 

  

https://searchcloudone.com/universal-desktop-search/
https://github.com/electronart/esearch-project-translation
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Registration 
After the general release date, beta testers, early evaluators, and users 
of similar products will be offered free or discounted TARILIO licenses. 
You need to register your email address when you download eSearch Pro or 
Portable to be eligible for those offers or for technical support. 

 

 

eSearch Pro 
Available in Desktop or Portable. Free and open source for private non-
commercial use from ‘July 2025’ release. 

The Portable version can be run on a USB 3.x drive complete with documents 
and indexes as a portable library or to index and search files stored on 
the host machine.  

 

Portable-search-only licenses allow you to publish searchable libraries to 
others, with no expiry. These require a serial number and a TARILIO 
Publish license. 

See SearchCloudOne.com for more information and pricing.  

 

Evaluation 
eSearch Pro may be downloaded free from SearchCloudOne.com. Versions up to 
and including the June 2005 release, will revert to a free Lite mode with 
limited features. Version after that date will remain fully functional. 
You may use the eSearch versions for 30-day evaluation commercial use. 

 

TARILIO versions. 
If you have purchased a TARILIO license, enter the serial number to remove 
any limits and gain access to support and updates. To enter the serial 
number: go to Help menu > About > Serial… TARILIO versions require an 
annual subscription and revert to a Lite version after one year. 

 

eSearch Lite 
Lite version is free for personal and commercial use. For support and 
updates, please register your email address with 
support@electronart.co.uk. The Lite version has limited functionality, 
such as restrictions on the number of results or features available in the 
Pro version. These limits may change over time and will be published on 
our website or in user guides.   

https://searchcloudone.com/universal-desktop-search/
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Support 
 
TARILIO versions: Support is provided via email to a single point of 
contact within an organization. Always supply your serial number or 
details of when and where the product was purchased if it was not obtained 
directly from SearchCloudOne.com or ElectronArt Design Ltd. 

Use the contact form on the About menu at http://SearchCloudOne.com or 
email support at support@electronart.co.uk. 

 
Support Articles can be found here: 
https://searchcloudone.com/esearch-support-articles/ 

Feedback 
We welcome feedback, bug reports, suggestions, and translations at any 
time! Use the contact form at https://searchcloudone.com/contact-us/ or 
email support at support@electronart.co.uk. 

If you experience problems, please describe the steps to recreate the 
issue, along with brief details of your computer hardware, operating 
system, and any specific file type causing the problem. Screenshots may 
help us understand the issue. 

Error Log 
 

During indexing, if errors 
are detected an error log 
will be created. If you 
click on View log it will be 
opened in Notepad or your 
default text editor.  
 

 
 

 
Copy and paste the text into an email. If the file is large, compress it 
into a Zip format and attach it to the email. To create a text file, see 
the File menu and select Save As…. Then, right-click the file and choose 
Compress to ZIP. Send the log (redacted if necessary) to 
support@electronart.co.uk. 
 

OneDrive 
Ensure that Status is 
synchronized to ensure 
proper indexing.  

http://searchcloudone.com/
mailto:support@electronart.co.uk
https://searchcloudone.com/esearch-support-articles/
https://searchcloudone.com/contact-us/
mailto:support@electronart.co.uk
mailto:support@electronart.co.uk
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Known Issues 
Viewer Settings 

View Large Files:   

For large (except CSV or JSONL) files, such as 160MB Reuters headlines 
(TREC data), if “Fully” is selected, eSearch will become non-responsive 
until the file is read in, which can take several seconds. In contrast, 
large (multi-gigabyte) CSV or JSONL files are indexed as separate 
records and are handled without issues. 

PDF 
PDF Viewer has no hit highlighting. Choose Plain Text to view PDF files 
with hits highlighted. 

Viewer/File support 
File parsers are in continuous development, if you encounter issues, try 
downloading a later build and rebuilding your indexes to see if the 
problem has been resolved. For specific needs or unresolved issues, 
contact support at support@electronart.co.uk. 

Hit count navigation was added in response to customer requests. While 
dtSearch Desktop lists the total number of hits in the results, it does 
not identify a particular hit when using 'next hit'/'previous hit' 
navigation. In contrast, eSearch Pro numbers each hit. 
 
In extreme cases, such as when an index is created with stop words set 
to ‘none’ and a search is performed on a common word like 'a', there can 
be thousands of hits in a long English document. Since such a search is 
unlikely to be useful, we have limited the maximum number of hits 
counted to 1024. Documents are displayed immediately, but counting and 
highlighting 1024 hits can take 10 secs or more, depending on the 
document and the machine. 
 

Plugins menu 
The plugin API will allow developers to create plugins for connecting to 
external data sources. A demonstration plugin is available for download, 
see plugins, however the API has not yet been published (As of June 
2025). 

 
 
 
 
 
 
 
 
 
 
 

mailto:support@electronart.co.uk
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Accessibility 

 
All controls respond to the Windows Narrator Screen Reader, which can be 
turned on or off with the keyboard shortcut Windows + Ctrl + Enter.  
See: Keyboard shortcuts. 
 
High Contrast option: See View > Theme menu items. 
 
 

Search bar now has a voice input option. This 
works offline using the built-in Microsoft 
Windows technology.  

 

 

 

You can also use applications like VoiceTyper. Use the ‘forward slash’ 
[/] key to put the cursor in the search bar before talking. 

 

File menu > Launch at Start-up option 

 

Command Line options 
-s Disables Index menu. 
-a Disables AI Mode. 
-x Disables AI > AI Connections menu 
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Issue 38 
 

eSearch Pro 

Beta status 
 
July 2025: eSearch Pro is now open sourced and is free of charge for 
private, non-commercial use. TARILIO includes additional closed source 
code and is the brand for commercial use.  

https://github.com/electronart/esearch-project 
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